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NEW QUESTION 1
Which two extended capabilities must be configured on dial peers for fast start-to-early media scenarios (H.323 to SIP interworking)? (Choose two.)

A. DTMF
B. BFCP
C. VIDEO
D. FAX
E. AUDIO

Answer: AB

NEW QUESTION 2
When you troubleshoot H.323 call setup, which message informs you that the called party is being notified about the call?

A. ALERTING

B. PROCEEDING
C. CONNECT

D. RINGING

Answer: C

NEW QUESTION 3
An administrator is troubleshooting call failures on an H.323 gateway via the CLI. To see signaling for media and call setup, which debug must the Administrator
turn on?

A. debug H.323 messages
B. debug H.225 asnl

C. debug H.246 asn 1

D. debug H.225 media

E. debug H.323 asn 1

Answer: B

NEW QUESTION 4

What is first preference condition matched in a SIP-enabled incoming dial peer?
A. incoming uri

B. target carrier-id

C. answer-address

D. incoming called-number

Answer: A

NEW QUESTION 5

Which section under the Real-Time Monitoring Tool allows for reviewing the call flow and signaling for a SIP call in real time?
A. Analysis Manager > Inventory > Trace File Repositories

B. System > Tools > Trace and Log Central

C. Voice/Video > Session Trace Log View > Real Time Data

D. Voice/Video > Session Trace Log View > Open From Local Disk

Answer: C

NEW QUESTION 6
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Refer to the exhibit. A user reports that when they call a specific phone number, no one answers the call, but when they call from a mobile phone, the call is
answered. The engineer troubleshooting the issue is expecting the far-end gateway to cut through audio on the 183 Session Progress SIP message. Which SIP
Profile configuration element is necessary for the Cisco Unified Communications Manager to send acknowledgement of provisional responses?
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A. Allow Passthrough of Configured Line Device Caller Information must be enabled.

B. Accept Audio Codec Preferences in Received Offer must be set to On.

C. On the SIP Profile, the configuration parameter SIP Rel1XX Options must be set to Send PRACK for all 1xx Messages.
D. Early Offer for G Clear Calls must be enabled.

Answer: C

NEW QUESTION 7
Which top-level IOS command is needed to begin the configuration of a Cisco Unified Communications Manager Express gateway to enable phones to be
registered via SIP?

A. allow-connections sip to sip
B. voice service voip

C. voice register global

D. voice register dn

Answer: C

NEW QUESTION 8
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Refer to the exhibit. Calls incoming from the provider are not working through newly set up Cisco Unified Border Element. Provider engineers get the 404 Not
Found SIP message. Incoming calls are coming from the provider with called number “222333444"” and Cisco Unified Communications Manager is expecting the
called number to be delivered as “444333222". The administrator already verified that the IP address of the Cisco Unified CM is set up correctly and there are no
dial peers configured other than those shown in the exhibit. Which action must the administrator take to fix the issue?

A. Change the destination-pattern on the outgoing dial peer to match “444333222".

B. Set up translation-profile on the incoming dial peer to match incoming traffic.

C. Create specific matching for “222333444” on the incoming dial peer.

D. Fix the voice translation-rule to match specifically number “222333444” and change it to “444333222".

Answer: B

NEW QUESTION 9
A user in location X dials an extension at location Y. The call travels through a QoS-enabled WAN network, but the user experiences choppy or clipped audio.
What is the cause of this issue?

A. missing Call Admission Control
B. codec mismatch

C. ptime mismatch

D. phone class of service issue

Answer: B

NEW QUESTION 10
An engineer must route all SIP calls in the form of <user>@example.com to the SIP trunk gateway corporate local. Which two SIP route patterns can be used to
accomplish this task? (Choose two.)

. example.com@gateway.corporate.local
. *@example.com

. gateway.corporate.local

. example.com

* %

moowp»

Answer: BE

NEW QUESTION 10
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Which two statements are correct with respect to the Client Matter Code setting in the route pattern configuration? (Choose two.)

A. The Client Matter Code feature does not support overlap sending because the Cisco Unified CM cannot determine when to prompt the user for the code.

B. If you check the Allow Overlap Sending check box, the Require Client Matter Code check box becomes disabled.

C. If you check the Allow Overlap Sending check box, you can also check the Require Client Matter Code check box.

D. The Client Matter Code feature does support overlap sending because the Cisco Unified Communications Manager can determine when to prompt the user for
the code.

E. The Client Matter Code has the option to configure Authorization Level such as in the Forced Authorization Code.

Answer: AB

NEW QUESTION 13
A network engineer designs a new dial plan and wants to block a certain range of numbers (8135100 through 8135105). What is the most specific route pattern
that can be configured to block only the numbers in this range?

A. 813510[012345]
B. 813510[12345]
C. 813510[0-5]

D. 81XXXXX

Answer: A

NEW QUESTION 16
If all patterns below are configured in Cisco Unified Communications Manager which would be used when dialing the pattern “123"?

A. 12!

B. 12X (urgent priority set)
C. 1XX (urgent Priority Set)
D. 12[2-5]

Answer: B

NEW QUESTION 18
The Cisco Unified Communications Manager Dialed Number Analyzer allows analysis of calls from which two devices? (Choose two.)

A. translation patterns
B. device pools

C. CTl ports

D. CTI route points

E. IP phones

Answer: CE

NEW QUESTION 19
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Refer to the exhibit. An administrator is troubleshooting a situation where a call placed from a phone registered to Cisco Unified Communications Manager does
not complete. The administrator wants to use the Dialed Number Analyzer on Cisco Unified CM to check which translation pattern the call is matching. However,
when logging in to Cisco Unified Serviceability there is no option for Dialed Number Analyzer under the tool menu. Which two steps must be performed to resolve
this issue? (Choose two.)

A. Restart the subscriber
B. Activate the Cisco Extended Functions service.
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C. Activate the Cisco CallManager service.

D. Activate the Cisco Dialed Number Analyzer service.
E. Activate the Cisco Dialed Number Analyzer Server service.

Answer: DE

NEW QUESTION 24

In Cisco Unified Communications Manager globalized call routing is implemented and must confirm that it is correctly implemented without making a call. Which

tool do you use for verification?
A. Dialed Number Analyzer

B. Real-Time Monitoring Tool
C. SDl trace

D. SDL trace

Answer: A

NEW QUESTION 27
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Refer to the exhibit. Within the North American Numbering Plan, gateways located in Ottawa, Canada and marked as “YOW?" are assigned to the Calling Party
Transformation CSS NANP_CgPTP, which contains partition NANP_calling_xforms. What is the calling-party number and the numbering type if the calling user

+1613-555-1234 dials the number?

A. calling number 613-555-1234 and numbering type “subscriber”

B. calling number 011-1-613-555-1234 and numbering type “subscriber”
C. calling number 011613-555-1234 and numbering type “international”

D. calling number 613-555-1234 and numbering type “national’

Answer: D

NEW QUESTION 30

An engineer is configuring a call park feature in Cisco Unified Communications Manager Express. Which command does the engineer use to ensure that the call is

reverted to the user after 60 seconds?

A. R2(config-ephone-dn)#park reservation-group 60

B. R2(config-ephone-dn)#park-slot timeout 60 limit 2 recall alternate 3002
C. R2(config-ephone-dn)#park reservation-group 1
D. R2(config-ephone-dn)#park-slot timeout 30 limit 2 recall alternate 3002
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Answer: B

NEW QUESTION 32
Which call pickup feature allows users to pick up incoming calls in a group that is associated with their own group?

A. Other Group Pickup
B. BLF Call Pickup

C. Group Call Pickup
D. Directed Call Pickup

Answer: A

NEW QUESTION 33
When locations-based Call Admission Control denies the call, which two masks can AAR apply when routing the call through the PSTN? (Choose two.)

A. AAR destination mask

B. called party transform mask

C. external phone number mask

D. +E.164 alternate number mask
E. enterrise alternate number mask

Answer: AC

NEW QUESTION 37
When configuring hunt groups, where do you add the individual directory numbers that will be part of the group?

A. route group
B. line group
C. hunt list

D. hunt pilot

Answer: B

NEW QUESTION 39
Which configuration element of a hunt group allows for changing Calling Party Transformations settings?

A. line group
B. hunt pilot
C. route group
D. hunt list

Answer: B

NEW QUESTION 40
Which two types of authentication are supported for the configuration of Intercluster Lookup Service? (Choose two.)

A. TokenID

B. username and secret key

C. TLS certificates

D. passwords

E. FQDN of the servers defined in DNS

Answer: CD

NEW QUESTION 42
A user reports that when they attempt to log out from the Cisco Extension Mobility service by pressing the Services button, they cannot log out. What is the most
likely cause of this issue?

A. The Cisco Extension Mobility service has not been configured on the phone.

B. There might be a significant delay between the button being pressed and the Cisco Extension Mobility service recognizing i
C. It would be best to check network latency.

D. The user device profile has not been assigned to the user.

E. The user device profile is not subscribed to the Cisco Extension Mobility service.

Answer: D

NEW QUESTION 47

What is a component of Cisco Unified Mobility?
A. Unified IVR

B. Mobile Connect

C. Smart Client Support

D. Single Number Connect

Answer: B
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NEW QUESTION 49
A user reports when they press the services key they do not receive a user ID and password prompt to assign the phone extension. Which action resolves the
issue?

A. Create the default device profiles for all phone models that are used.
B. Subscribe the phone to the Cisco Extension Mobility service.

C. Create the end user and associate it to the device profile.

D. Assign the extension as a mobile extension.

Answer: B

NEW QUESTION 51

Which services are needed to successfully implement Cisco Extension Mobility in a standalone Cisco Unified Communications Manager server?
A. Cisco Extended Functions, Cisco Extension Mobility, and Cisco AXL Web Service

B. Cisco CallManager, Cisco TFTP, and Cisco CallManager SNMP Service

C. Cisco CallManager, Cisco TFTP, and Cisco Extension Mobility

D. Cisco TAPS Service, Cisco TFTP, and Cisco Extension Mobility

Answer: C

NEW QUESTION 53

Guaranteed success with Our exam guides visit - https://www.certshared.com



Certshared now are offering 100% pass ensure 300-815 dumps!
r_l CEFtSharEd https://www.certshared.com/exam/300-815/ (118 Q&AS)

Thank You for Trying Our Product

We offer two products:

1st - We have Practice Tests Software with Actual Exam Questions

2nd - Questons and Answersin PDF Format

300-815 Practice Exam Features;

* 300-815 Questions and Answers Updated Frequently
* 300-815 Practice Questions Verified by Expert Senior Certified Staff
* 300-815 Most Redlistic Questions that Guarantee you a Pass on Y our FirstTry

* 300-815 Practice Test Questionsin Multiple Choice Formats and Updatesfor 1 Y ear

100% Actual & Verified — Instant Download, Please Click
Order The 300-815 Practice Test Here

Guaranteed success with Our exam guides visit - https://www.certshared.com


https://www.certshared.com/exam/300-815/
http://www.tcpdf.org

